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Chapter 1: Overview 
Viewpoint Stream Tuning Studio and 
Viewpoint Experience Technology (VET) 
Viewpoint Experience Technology (VET) is Viewpoint Corporation’s unique technology that streams 3D and rich 
media content over the Internet via Viewpoint Media Player, a Web browser plug-in. Viewpoint Stream Tuning 
Studio is a production tool that optimizes 3D scene files created in Viewpoint Scene Builder, Viewpoint 3D Photo 
Studio, or other applications, such as 3ds max or Maya. When viewed on a Web page, the optimized 3D scene 
streams quickly and retains visual integrity  
Viewpoint Stream Tuning Studio allows you to dramatically reduce scene file size and control the visual 
presentation of objects during loading. Use Stream Tuning Studio to optimize uncompressed .mts files before you 
embed your VET scene in a Web page. In some cases, an .mts file can be reduced by as much as 70% by filling or 
removing unused texture pixels, rotating textures, decreasing the geometry count, resizing textures, reducing the 
quality of textures, and merging texture coordinates and vertices.  

New Features in This Upgrade 
Stream Tuning Studio 2.0 has powerful new features allowing you to make your scene files leaner than ever.  
• Improved UI and Work Path  For a simpler, more intuitive workflow. Stream Tuning Studio compresses .mts 

files, but never alters any .mtx file. It also does not change the name of an .mts file or restructure the scene 
content hierarchies contained in it.  

• More Robust Image Viewing  Gives you more control and visual feedback. Allows loading textures or 
lightmaps, as well as reload functionality. 

• Fill Unused Pixels  Fills unused parts of textures with a uniform color (typically reduces file size by 5-30% 
without loss of quality). 

• Rotate Textures  Allows better packing of textures (up to 20 % file size savings) without compromising visual 
fidelity or interfering with Flash animations on top of textures.  

• Merge Textures  Allows you to create a texture collage map that enhances 3D streaming performance. 
• Mixed JPEG/TrixelsNT Compression  You can now choose the optimal compression—either JPEG or 

TrixelsNT—by texture. 
• Untile Tiled Textures  Allows you to play Flash animations on tiled textures. 
• Solo Mode and Object Selection  Allow convenient visualization of individual objects in a scene with Solo 

camera mode and the Object list.   
• Marquee Zoom and Platter Mode  As with Viewpoint Media Player, these camera and mouse navigation 

options are available.  
• Supports for Normals  With CAD/CAM models exported as Viewpoint Media Files (.mtx and .mts). 

Minimum System Requirements 
• 200 MHz Intel Pentium processor 
• 64 MB system RAM 
• 10 MB free hard disk space 
• 16-bit color display (24-bit recommended) 
• 1024 × 768 minimum monitor resolution  
• Windows 98, NT 4.0, or 2000  
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Required and Recommended Software 
Stream Tuning Studio is a utility that works as part of Viewpoint Experience Technology (VET) and is designed for 
use with the following software. 

VET Applications 
• Viewpoint Media Player (required)  The Web browser plug-in that streams rich media and is required for 

viewing and interacting with VET.  
• Viewpoint Scene Builder  Use this application to put the finishing touches on your 3D scene, such as lightmaps, 

textures, widgets (hotspots with descriptive text), and animations. Then, publish your scene to .mts and .mtx, 
the Viewpoint Media File formats. 

Important: Procedural geometries from Scene Builder and their applied textures cannot be optimized.  

• Viewpoint 3D Photo Studio  Creates Web-ready 3D images by combining high-quality photography with image 
editing, the end result of which are 3D product images. Exports to .mts and .mtx, the Viewpoint Media File 
formats. 

Other Resources 
• Macromedia Flash™  Use Flash files in place of JPEG textures to dramatically reduce file sizes. 
• 3ds max (formerly, 3ds max)  Convert .3ds files to .ase in 3ds max, in order to import them into Scene 

Builder. Or, export scenes directly from 3d max to Viewpoint Media Files. Then, optimize the scene in Stream 
Tuning Studio. 

• 3D stock art from Viewpoint  Files in .3ds format can be purchased from Viewpoint’s Web site. 

Note: Although VET supports files exported from Poser, optimizing these files through Stream Tuning Studio 
is not recommended. 
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Chapter 2: 
Preparing a Scene File for Optimization 
Viewpoint Stream Tuning Studio optimizes uncompressed .mts files from Viewpoint Scene Builder and other 
applications that export .mts files. Optimize other files, such as .obj and ase, by bringing the files through Scene 
Builder first, as the diagram on the right illustrates. Convert .3ds files to .ase in 3ds max first, in order to import 
them into Scene Builder. 

Note: For best results using Stream Tuning Studio, tiled textures must have dimensions that are powers of 2; 
some examples are 8 × 16, 256 × 256, and 512 × 1024. 

Create a Scene in 
Viewpoint Scene Builder 
To get the best results from Viewpoint 
Stream Tuning Studio, follow the 
instructions below to publish a scene from 
Scene Builder. 

Important: Procedural geometries  
from Scene Builder and their applied 
textures cannot be optimized.  

To publish .mts and .mtx files 
from Scene Builder 
1 Create a scene in Scene Builder. 
2 From the Load/Publish menu, 

choose Publish for Tuning Studio to 
publish the .mtx file and 
uncompressed .mts file.  

Note: By publishing an 
uncompressed .mts file, you avoid 
compressing the file twice and 
degrading visual quality. 

To learn more about using Scene Builder, 
download the Viewpoint Scene Builder User Guide. 

 

http://developer.viewpoint.com/
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Convert .3ds, .obj, and .ase files to Viewpoint Media Files 
Viewpoint Stream Tuning Studio opens an .mtx file and its associated .mts file (although, only the .mts file contents 
are optimized). Follow the procedures below for using Viewpoint Scene Builder to convert .obj and .ase files for 
optimizing. Convert .3ds files to .ase in 3ds max, so that you can convert them with Scene Builder. 
To learn more about using Scene Builder, download the Viewpoint Scene Builder User Guide. 

To convert a .3ds file 
1 Open the .3ds file in 3ds max. 
3 Export the file as .ase. For further instructions, see Viewpoint MAX 2 ASE Tutorial. 
4 Launch Viewpoint Scene Builder. 
5 On the Load/Publish menu in Scene Builder, click Import ASE. 

Choose the .ase file you’ve just exported from 3ds max, and then click Open. 
6 If the file contains animations, in the ASE Behavior Editor dialog box, type the names you want to give 

animation actions and their frame ranges. (If your file does not contain animations, this dialog does not display 
upon loading the file.)  
To review and edit this information later, click the Anim Dialog button on the Load/Publish menu. 

7 Use the powerful features in Scene Builder to add lightmaps, textures, additional animations, widgets 
(procedural geometry that displays descriptive text when triggered by an OnClick, for instance), or change the 
camera orientation—just to name a few of the things you can do.  
For more information, see the Viewpoint Scene Builder User Guide. 

8 When your scene is complete, choose Publish for Tuning Studio from the Load/Publish menu to publish the 
.mtx file and uncompressed .mts file. By publishing an uncompressed .mts file, you avoid compressing the file 
twice and unintentionally degrading the visual quality.  

The scene is now ready to be optimized in Viewpoint Stream Tuning Studio. 

To convert a Wavefront .obj file 
1 Launch Viewpoint Scene Builder. 
2 On the Load/Publish menu, click Add OBJ. 
3 Use the powerful features in Scene Builder to add lightmaps, textures, additional animations, widgets 

(procedural geometry that displays descriptive text when triggered by an OnClick, for instance), or change the 
camera orientation—just to name a few of the things you can do. 
For more information, see the Viewpoint Scene Builder User Guide. 

4 When you are finished with your scene, on the Load/Publish menu, choose Publish for Tuning Studio to 
publish the .mtx file and uncompressed .mts file. By publishing an uncompressed .mts file, you avoid 
compressing the file twice and unintentionally degrading the visual quality. 

The scene is now ready to be optimized in Viewpoint Stream Tuning Studio. 

http://developer.viewpoint.com/
http://developer.viewpoint.com/
http://developer.viewpoint.com/
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To convert an .ase file 
1 Launch Viewpoint Scene Builder. 
2 On the Load/Publish menu in Scene Builder, click Import ASE. 
3 Choose the .ase file you want to convert, and then click Open. 
4 In the ASE Behavior Editor dialog box, type the names you want to give to the animation actions and their 

frame ranges.  

Note: To review and edit this information later, click the Anim Dialog button on the Load/Publish menu. 

5 Use the powerful features in Scene Builder to add lightmaps, textures, additional animations, widgets 
(procedural geometry that displays descriptive text when triggered by an OnClick, for instance), or change the 
camera orientation—just to name a few of the things you can do. 
For more information, see the Viewpoint Scene Builder User Guide. 

6 When your scene is complete, choose Publish for Tuning Studio from the Load/Publish menu to publish the 
.mtx file and uncompressed .mts file. By publishing an uncompressed .mts file, you avoid compressing the file 
twice and unintentionally degrading the visual quality.  

The scene is now ready to be optimized in Viewpoint Stream Tuning Studio. 

http://developer.viewpoint.com/
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Chapter 3: 
Getting Started With Stream Tuning Studio 
Install and Start Stream Tuning Studio 
1 To install Stream Tuning Studio, double-click the Viewpoint Stream Tuning Studio installation file and follow 

the on-screen instructions. Tutorial files referred to in this guide are copied to your computer in C:\Program 
Files\Viewpoint\Viewpoint Stream Tuning Studio\Tutorial. 

2 On the Start menu, click the Viewpoint folder, and then click Viewpoint Stream Tuning Studio. 

Uninstall Stream Tuning Studio 
• To uninstall the application, use Add/Remove Programs in the Windows Control Panel. Or, run unwise.exe 

located in the folder with the application (C:\Program Files\Viewpoint\Viewpoint Stream Tuning Studio).  

Important: Never uninstall by deleting the application folder, because this does not uninstall the application 
completely. 

Walk Through the Stream Tuning Studio Interface 

Main Window 

 
The Stream Tuning Studio window as it appears when you select an .mts file, and then click the  
View/Optimize button under Project Files. Image Viewer has also been selected from the Material menu
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Toolbar 
Toolbar icons give you quick access to the following functions: 

 
 Open (Ctrl + O) Open an .mtx file to optimize its associated .mts file.  

 
Select Object  Click objects to select them. 

 
Undo (Ctrl + Z)  Stream Tuning Studio lets you go back and undo multiple changes to a file.  

 
Redo (Ctrl + Y) Reapplies the last action(s) for which you chose Undo. 

Expanding and Collapsing Tools 
Tools can be expanded and collapsed to display or hide their functionality. Collapse tools you aren’t using if the 
screen becomes too crowded.  

 
Click the arrowhead next to the tool name  
to !!!!expand (show) or """"collapse (hide) tools. 

Tip: You can close tools if the tool pads become too crowded. Right-click a tool title, such as Scene Statistics, 
and then click Close. 

Basic Program Functions 

Open a Scene 

Note: Much like editing a bitmap image, optimizing a scene cannot be reversed once the scene is saved. Always 
back up your original files before you optimize a scene in Stream Tuning Studio.  

In Stream Tuning Studio, you open a Viewpoint scene by opening an .mtx file that references an .mts file. 

1 From the File menu, choose Open. Or, click  on the toolbar. 
2 Choose the .mtx file for the scene you want to optimize, and click Open. 

Important: Although you use the .mtx file to reference the .mts file you are optimizing, the .mtx file is never 
changed or saved by Stream Tuning Studio. You can only optimize and save the .mts file with this tool. 

Collapsed tool. Only some of  
the functionality is displayed. 
Expanded tool. All of the  
functionality is displayed. 



  Viewpoint Stream Tuning Studio User Guide  

 

© 2000-2001 Viewpoint Corporation. All rights reserved.  Page 12 of 37 

 

Reload a Scene 
When you are finished optimizing your scene, reload the .mtx file to test how the scene streams. 
1 Under Project Files on the left tool pad, click Reload Scene to load the .mtx file. 
2 To save your optimization settings, click Yes when you are prompted to Save all changed MTS files. 

Save a File 
Stream Tuning Studio saves and compresses only the .mts file. The .mtx file remains unchanged. 
• With the .mts file in View Optimize mode, choose Save from the File menu. 

Note: To maintain visual fidelity, do not resave a file you’ve already optimized and saved. 

Left Tool Pad Functions 
Tools are presented here in the order they appear on the left side of the screen. 

Note: To close a tool pad, right-click it and then click Close. 

Project Files (formerly MTS Contents) 
Displays when you open an .mtx file. 
The Project Files tool displays when you open an .mtx file and has two primary functions: 
• Reload Scene  Allows you to load the scene at the speed specified in the Modem Simulator tool. To test scene 

loading, click the .mtx file name, set the preferred connection speed in Modem Simulator, and then click 
Reload Scene. 

• View/Optimize  Loads the .mts file for optimization. To begin optimizing an .mts file, click the file name, and 
then click View/Optimize. 

Tip: You can also double-click a file name in Project Files to load it. 

 
Project Files lets you choose an .mts file  
for optimization or reload the scene. 
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Camera 
Displays when you load an .mts file. Also displays with limited functionality when you load an .mtx file. 

 
Camera controls let you manipulate the  
object view when the .mts file is loaded. 

Use the following camera tools to change object view and revert it to home position again: 

  
Rotate Camera (Alt) allows you to view the object from all angles. 

  Home returns the object to its original position. 

 View Selected Objects zooms the selected object into view. Select one or more objects by 
clicking the Pick Object tool (in the tool bar), and then clicking the object (or Ctrl + click 
more than one object) you want to view. Click the View Selected Objects button.  

 View All Objects zooms view to show all selected objects. 

 
Choose Platter Mode to simulate the camera navigation of Viewpoint Media Player.  

  
In Solo Mode, you can cycle the camera through the objects in a scene one at a time (for a 
scene containing more than one object). On the keyboard, press F11 or Shift + F11 to cycle 
down or up through the object list. Use Solo Mode to easily view overlapping or hidden 
objects.  

 
When the .mtx file is loaded, you can set  
the default home position of the camera. 

Note: Home camera position is for viewing and editing scenes in Stream Tuning Studio. It is not saved when 
you save your optimized scene. 

To reset the home position of an object 
1 Open a scene, or load an .mts file.  

To open a scene, choose Open from the File menu. Or, click           on the toolbar.  
To load an .mts file, click the name of the .mts file listed under Project Files. Then, click View/Optimize. 

2 On the Camera: 3D View tool on the left, click the Rotate Camera tool. 
3 Click the object and drag it to the home position you want to use. 
4 At the top of the right tool pad, click Set Home Position under Camera Options. 
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Modem Simulator  
Open an .mtx file or reload the scene, and then choose Modem Simulator from the Scene Builder menu. 
Modem Simulator allows you to test your optimized file at various Internet connection speeds. Modem Simulator 
reads the .mtx file and streams the geometry and textures as specified in the combined .mts and .mtx files. This is 
especially useful for verifying whether a scene is well optimized for lower speed Internet connections. 

 
Modem Simulator allows you to verify  
how your model renders at various  
Internet connection speeds. 

To test a scene with Modem Simulator 
1 Open an .mtx file. Or, select the file in the Project Files area, and then click the Reload Scene button. 
2 Choose Modem Simulator from the Scene Builder menu. 
3 From the Bandwidth drop-down list, choose the connection speed you want to test. Then, under Project Files, 

click the Reload Scene button. 
Repeat this step for each connection speed you want to verify. 

Note: Select the Pause checkbox to pause streaming the scene. Deselect the checkbox to continue streaming. 

Rendering Options 
Available when you load an .mts file. Limited functionality when the .mtx file is loaded. 
The Rendering Options tool contains five rendering modes and also allows you to set additional parameters to 
change the display of objects in a scene. These options only change the way the model appears on-screen. They do 
not affect the geometry or textures of the model and are not saved in the file. 

 
Rendering Options allows you to choose  
different working views of a scene.  
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Choose from five rendering options: 
• Points  Displays only the vertices of the triangles that make up the object. Because Points mode contains the 

least information of any of the rendering modes, it renders fastest.  
• Wireframe  Shows the polymesh—the triangles that make up the object’s geometry. Use Wireframe mode to 

view objects as a geometric mesh. You can set the Wireframe color in the Colors tool (choose Colors from the 
Edit menu). 

• Solid with Flat Shading  Displays each triangle in the polymesh as a single value. You see the contours of 
objects, but they appear as triangular planes, rather than as a continuous, smooth surface. Use this mode to see 
the distinct geometric surfaces that make up an object. 

• Solid with Smooth Shading  Displays objects with a smooth, continuous surface also called Gouraud shading. 
• Solid with Surface Texture  Displays objects in full color with surface texture. This is the full rendering mode 

that is used most often. 
Select other rendering options by clicking the corresponding checkboxes: 
• Two-Sided  Makes texturing visible on both sides of the object. For example, if you look at the backside of an 

object, you see a mirror image of the front texture. On the backside of the face, writing on the object appears 
backward. With Two-Sided unchecked, the object effectively disappears when you attempt to view the backside 
of its face. This setting has no visible effect if the model is a non-transparent, enclosed, watertight object. 

• Texturing  Turns on the display of texture on the objects in the scene. 
• Lighting  The default with the solid modes, it provides the sense of depth. If you uncheck Lighting while in a 

solid mode, the object displays as a flat silhouette on a solid background. 
• Hidden Line  A Wireframe mode option, that shows only the faces of the wireframe. The wireframe is not 

transparent in this mode. 
• Wire Decal  Places a wireframe over a solid object with or without texture. This allows you to correlate the 

wireframe to the visible contours of the object.  
• Object Outline  A colored line defines the edges of selected objects.  
• Bounding Boxes  Displays a three-dimensional rectangular box around each selected object. This box acts as a 

visual guide to tell you how much 3D space the object occupies. You can set the bounding box color in the 
Colors tool (choose Colors from the Edit menu). 

Dynamic Resolution 
Displays when you select an .mts file and click View/Optimize. 
Dynamic Resolution shows the number of triangles in an object and allows you to set the minimum quality of the 
initial scene the user sees when loading a Web page, as well as the maximum triangle count.  
Viewpoint 3D Photo Studio uses a triangular polygonal mesh to reconstruct a 3D object, with triangles as the basic 
unit. The polymesh may contain thousands of triangles, although you might need only a fraction of them to create a 
realistic model. Use the Dynamic Resolution slider to reduce triangle count while maintaining visual quality. 
For more information on using the Dynamic Resolution slider, see “Set Minimum Initial Viewing” and “Set 
Maximum Poly Count,” later in this guide. 

 
Use the Dynamic Resolution slider to  
reduce the triangle count of an object,  
while retaining its visual quality. 

Note: Dynamic Resolution preserves smoothing groups, but not creases. 
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Show Edges & Creases 
With an .mts file loaded, choose Show Edges & Creases from the Shape menu. 

 
Show Edges & Creases has four  
preview modes you can use to inspect  
the quality of a model. 

Use the preview options in Show Edges & Creases to see edges, creases, texture boundaries, and vertices of a model. 
These preview options can help you detect any anomalies with the object’s edge bias. You can also use these options 
to see texture or material boundaries. 
• Show Surface Edges  Check this option to highlight the surface edges of all triangulation. If the model is 

watertight, you should not see any surface edges. Use this option to look for small holes and degenerate 
triangles. 

• Show Crease Edges  Check this option to highlight any creases (that is, places where the normals change 
direction from facing towards you to facing away from you). 

• Show Texture Boundaries  Check this option to highlight the boundaries between textures. 
• Show Vertices  Check this option to see the location of all the vertices on the model. Drag the slider to adjust 

the size of the display. (Depending on the make your graphics card, dragging the slider may not have any effect 
on the appearance of your model.) 

 
Show Edges & Creases with Show Vertices selected.  



  Viewpoint Stream Tuning Studio User Guide  

 

© 2000-2001 Viewpoint Corporation. All rights reserved.  Page 17 of 37 

 

Objects 
Displays by default when you choose the .mts file and click View/Optimize. 
The Objects palette lists the selectable objects in a scene and allows you to view each one in by clicking on it in the 
list. Use Ctrl + click or Shift + click to select combinations of objects in the list.  

 
The Objects palette lists selectable  
objects in a scene. 

File Info 
Displays by default when the .mts file is loaded. You can also choose File Info from the File menu. 

File Info shows you the location and original size of your scene files. Click Calculate to see how optimize settings 
reduce overall file size (displays in the New Size field). 

 
File Info tool calculates the smaller,  
optimized file size. 
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Right Tool Pad Functions 
Tools are presented here in the order they appear on the right side of the screen. 

Note: To close a tool pad, right-click it and then click Close. 

Animation 
With the .mtx file loaded, choose Animation from the Scene Builder menu. 
The Animation tool shows your animations by name and allows you to play and stop a selected animation. 

 
Preview a scene’s animations  
with the Animation tool. 

Widgets 
With the .mtx file loaded, choose Widgets from the Scene Builder menu. 
The Widgets tool shows information about the widgets in a scene and allows you to display them for preview only.  

 
View information about a  
scene’s widgets. 
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Edit Material 
With an .mts file loaded, choose Edit Material from the Material menu. 

Note: If your model uses textures for all surfaces, editing materials does not affect look of the model. If a 
lightmap is applied to a model without textures, Ambient and Specular values have no effect. However, the 
Diffusive value, in this case, changes the color of the model. 

On the Edit Material tool, you can change the material properties of an object as follows: 
• Ambient  The color of the object’s base material where it is in the shadow. Click the color swatch to choose a 

different color from the Color dialog box. 
• Diffuse  The base material color of the object. Click the color swatch to choose a different color from the Color 

dialog box. 
• Specular  A material property that determines the color of the highlights on the object. Click the color swatch to 

choose a different color from the Color dialog box. 
• Transparency  Move the slider to change the transparency of an object. Moving the slider to the right makes the 

object more transparent. When the slider is all the way to the left, the object is opaque. 
• Shininess  Move the slider to the right to increase the amount of specular reflection. This slider is not available 

if the specular color is set to black. 

Note: The Edit Material tool changes material properties for the whole object only. It cannot change the 
material properties for individual parts of an object. 

 
Adjust the Material Properties of an .mts 
 file with the Edit Material tool. 

Colors (formerly Preferences) 
From the Edit menu, choose Colors.  
Stream Tuning Studio color settings allow you to customize the preview display of your scene. These colors are not 
saved in the optimized scene, because the .mtx file is not saved. 

 
Use the Colors palette to customize  
elements of the scene preview display. 
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To set Stream Tuning Studio preview display colors 
1 On the Edit menu, choose Colors. 
2 Click the color swatch next to the feature color you want to change.  

From the Color dialog box, choose a new color, and then click OK. 
Click the Defaults button to return preview colors to the default settings. 

Image Viewer 
With an .mts file loaded, choose Image Viewer from the Material menu. 
When you choose Image Viewer from the Material menu, the screen splits with the 2D view of the textures or 
lightmaps at the top of the window and the 3D object view at the bottom. Image Viewer allows you to replace 
existing textures or lightmaps with new texture map or lightmap images, including images from Adobe Photoshop®. 
Click the Textures or Lightmaps option button to switch between working with texture or lightmap images.  

 

To replace an existing texture or lightmap with a new one 
1 With the Image Viewer window open, click the Texture or Lightmap option button, depending on what kind 

of image you want to replace. 
2 Click the texture or lightmap you want to replace to select it. 
3 In the Image Viewer tool, click Load. 
4 Choose the new texture or lightmap, and then click Open. The new texture or lightmap now appears  

on the object. 

Tip: You can also copy texture maps and lightmaps from Adobe Photoshop. Follow steps 1 and 2 above, and 
then copy (Ctrl+C) and paste (Ctrl+V), or choose Paste Texture from Stream Tuning Studio’s Edit menu.  

To save a texture or lightmap file 
1 With the Image Viewer window open, click the Texture or Lightmap option button, depending on what kind 

of image you want to save. 
2 Click the texture or lightmap you want to save to select it. 
3 In the Image Viewer tool, click Save. 
4 Choose the new texture or lightmap, and then click Open. The new texture or lightmap now appears  

on the object. 

To delete a texture or lightmap 
1 With the Image Viewer window open, click the Texture or Lightmap option button, depending on what kind 

of image you want to delete. 
2 Click the texture or lightmap you want to delete to select it. 
3 Press Delete on your keyboard. 

Other Image Viewer features 
• Detailed texture view  Double-clicking any texture or lightmap causes another window to appear with a 

detailed texture view that also shows the texture’s UV mapping. To close this view, right-click on the window, 
and then click Close.  

• Image Viewer options  Right-click on any texture to choose options such as Select All or Fit to Window. 



  Viewpoint Stream Tuning Studio User Guide  

 

© 2000-2001 Viewpoint Corporation. All rights reserved.  Page 21 of 37 

 

Resize Textures  
From the Material menu, choose Resize Textures. 
An optimization tool that reduces texture size. You can build your models using textures with maximum resolution, 
and then use this tool to optimize the textures for streaming. You can also use this tool to see the dimensions of a 
texture in pixels. 

Note: Image Viewer must be open when you use this tool. On the Materials menu, choose Image Viewer. 

 
Resize Textures is one way to reduce  
overall file size by optimizing textures. 

To see the size of a texture 
1 On the Material menu, choose Image Viewer, and then choose Resize Textures. 
2 Click a texture to select it. 
3 In the Resize Textures tool, click the Pixels option button. 
4 The texture size in pixels appears in the Width and Height fields. 

To resize a texture 
If you choose one texture to resize, the texture is reduced to the percentage of surface area or to the pixel dimensions 
entered. 
1 On the Material menu, choose Image Viewer, and then choose Resize Textures. 
2 Click the texture you want to resize to select it.  
3 Click the Pixels or Area option button to choose how you want to resize the texture. 
4 To resize the texture while constraining its proportions, type the new number in the Width field. 
5 Click Set to accept the new texture size. 

To resize more than one texture at a time 
If you choose more than one texture to resize at once, total surface area of the textures is reduced to the percentage 
you enter. Each texture may be resized differently in inverse proportion to the surface area it occupies.  
1 On the Material menu, choose Image Viewer, and then choose Resize Textures. 
2 Crtl + click the textures you want to resize to select them.  

To deselect a texture you don’t want adjusted, press the Ctrl key and re-click the texture. 
3 Click the Area option button. Type the percentage to which you want overall texture size decreased. 

Note: The Area option resizes textures proportionate to the 3D surface area. 

4 Click Set to accept the new texture sizes.  
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Object Statistics 
With an .mts file loaded, choose Show Object Statistics from the Shape menu. 
Object Statistics summarizes information about the object, including number of surface edges, material boundary 
edges, texture crease edges, normals, and more. If Object Statistics is open, it updates automatically as you optimize 
a scene.  

 
Object Statistics tracks changes to a 
scene as you optimize it. 

Merge Vertices 
With an .mts file loaded, choose Merge Vertices from the Shape menu. 
Use Merge Vertices to remove small holes and degenerate triangles from the wireframe. Degenerate triangles have 
zero width (they are infinitely narrow). Such artifacts rarely exist on models created using Viewpoint 3D Photo 
Studio 3D, but they may appear in models generated in third-party software.  
Because some models contain large holes that are intentional, this tool lets you set the maximum size of the holes 
that it affects. 

 
Merge Vertices can fix minor holes in  
a model and reduce overall file size. 

Important: Use Merge Vertices with caution when optimizing a scene that contains more than one object. 

To merge vertices 
1 Open a scene, or load an .mts file.  

To open a scene, choose, choose Open from the File menu. Or, click          on the toolbar.  
To load an .mts file, click the name of the .mts file listed under Project Files. Then, click View/Optimize. 

2 From the Shape menu, choose Merge Vertices. 
The Merge Vertices tool opens to the right of the Object window. 
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3 Accept the default Distance parameter, or type in a new one and press Enter.  
Keep track of the number of merges by viewing the number below this box. The Distance parameter 
defines the maximum size of the merged hole (the default is 0.0001; units are fractions of the bounding 
box, so the maximum is 1).  

Note: As you merge vertices, you can keep track of the number of triangles in Dynamic Resolution and the 
number of vertices in Object Statistics. 

4 When the number of Merges is 1 or more, click the Merge button to merge the vertices. Keeping clicking the 
Merge button until there are no more merges. 

5 Check Add Point if you want the tool to rearrange the triangulation so that the degenerate triangles disappear. 
This option also allows you to close very large holes by adding vertices within them.  

6 If you find that this did not remove all the holes you wanted to remove (or if it removed some you didn’t want 
to), repeat steps 3 to 5. 

7 When you are satisfied with the results, click the √ button to apply your changes. Or, click the × button to 
cancel changes. 

Adjust Normals 
With an .mts file loaded, choose Adjust Normals from the Shape menu. 
Adjust Normals allows you to change the crease angle and/or make normals two-sided.  
Normals are vectors that define the direction geometry faces. The direction a normal points represents the outer 
surface of the geometry and, therefore, the outer surface of the object. 

 
Adjust Normals controls crease angle  
and makes normals one or two-sided. 

To make surfaces two-sided 
1 Check Two-Sided. 

Unchecking this option reverts the normals to one-sided. 
2 Click the √ button to apply or the × button to cancel. 

To change the crease angle setting 
1 Type a number in the Crease Angle field, or move the slider until the number you want displays. 

• When the crease angle is set to 0, the model appears flat shaded (with rough edges between adjacent 
triangles). 

• When the crease angle is 180, the model appears smooth-shaded. 
2 When you are satisfied with the results, click the √ button to apply your changes. Or, click the × button to 

cancel changes. 

Note: Dynamic Resolution preserves smoothing groups, but not creases. 
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Rotate Texture 
With an .mts file loaded, choose Rotate Texture from the Material menu. 
Rotate Texture is a powerful new tool allowing you to optimize textures for even greater file size reduction. By 
rotating odd-shaped textures, for instance, to an optimum angle to fit within a rectangle, file size is reduced without 
reduction of texture quality. UV texture coordinates are automatically adjusted so the texture is applied correctly to 
geometry. 

Note: Rotating textures does not affect the resolution of textures and does not change the appearance of the 
model. 

Rotate Texture also allows you to untile tiled textures. See Untile Tiled Textures for details. 

 
Rotate Texture is a powerful tool for  
reducing file size. 

To set optimal rotation on a texture  
1 Click the name of the .mts file listed under Project Files. Then, click View/Optimize to load it. 
2 On the Material menu, choose Rotate Texture. 

Image Viewer opens above the scene and Texture Coordinate view to the left of the scene. 
3 Double-click a texture to select it, and then click the Best button in the Rotate Texture tool. 

This selects the optimum angle of texture rotation. If the texture cannot be optimized by rotation, a warning 
box displays. 

Note: You can choose a custom angle of rotation, but for optimal results the texture rotation calculated when  
you click Best is recommended.  

4 Click the Set button to apply the rotation. 

Set Geometry Quality 
With an .mts file loaded, choose Set Geometry Quality from the Shape menu. 

Important: Set Geometry Quality functions are for advanced modelers only. Reduction of file size is minimal 
with this feature. The default value of 10 is best for most models. 

Set Geometry Quality adjusts the quality of a model’s geometry by bits. As in 2D images, the higher the number of 
bits, the higher the model’s quality. Choose the smallest number that still produces acceptable visual quality. 

 
When you set geometry quality, more  
bits means higher quality, but also  
larger, slower files.  
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To set geometry quality 
1 Type a number in the Geometry Quality field. Or, click the up or down arrows next to the field to choose a 

number. 
Choose the lowest number of bits that still produces an acceptable visual effect. 

2 When you are satisfied with the results, click the √ button to apply your changes. Or, click the × button to 
cancel changes.  
If you apply changes, you can preview the difference in file size with File Info. 

Note: Increasing the bit level from the scene’s original setting does not create a higher resolution, just as you 
cannot increase the resolution of a scanned image after it is captured. 

Set Texture Quality 
With an .mts file loaded, choose Set Texture Quality from the Material menu. 
In this new release, you can use the Set Texture Quality tool to apply either JPEG or TrixelsNT compression to 
textures in a model; whereas, in the previous version, you had to choose one texture compression format for the 
entire scene. 
Use Set Texture Quality to preview the model at different levels of texture compression and also to set the level and 
type of texture compression for each texture. The type of compression is defined by the compression in the image 
that you open. This tool also allows you to set the compression levels of lightmaps, although this functionality is 
rarely used. Follow these steps to view and change the texture quality: 

Note: You must have the Image Viewer tool open to set the quality levels for individual textures.  

 
Set Texture Quality lets you preview  
the effects of texture compression on  
your scene. 

To set texture quality 
1 On the Material menu, choose Image Viewer, and then choose Texture Quality. 
2 Ctrl + click the texture(s) you want. 

In the Quality field, the selected texture’s quality displays.  
3 To change the texture quality, type a value in the Quality field. You can also click the option button next to 

either JPEG or TrixelsNT to choose the type of compression. Press Enter to accept these settings.  
4 Click the Compressed option button to preview the model at the set resolution level.  
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Chapter 4: 
Optimizing a File Step-by-Step 
Stream Tuning Studio allows you to optimize scenes for fast loading and visual quality. Using the sample files 
provided, follow the steps described for best results when optimizing.  

Always Backup Your Files Before Optimization 
Backing up your original files as you make large incremental changes to them is a good production practice whether 
you are working in 2D or 3D. That way, you always have original, uncompressed files to go back to if you want to 
make changes.  
When you optimize an .mts file in Stream Tuning Studio, you irreversibly compress the file and lose some of the 
original information and image quality. This optimization can make for excellent rendering times over the Internet. 
However, if you don’t like the quality of the optimized scene, you need to have a copy of the original, uncompressed 
.mts file if you want to start over and apply different optimization settings. 

To save a backup copy of scene files 
1 Double-click the My Computer icon, and locate the folder that contains the scene you want to optimize. 
2 Create a folder in the scene folder and name it Backup Copy. 
3 Ctrl + click the .mts and .mtx files for the scene you want to optimize, and then choose Copy (Ctrl + C) from 

the Edit menu. 
4 Double-click the Backup Copy folder to open it. 
5 From the Edit menu, choose Paste (Ctrl + V) to put copies of the scene files in the Backup Copy folder. 

Note: It’s a good idea to save a backup copy of scene files, even after you’ve completed production and posted 
them on the Web. Save the original uncompressed .mts and accompanying .mtx files, as well as any native files 
from other 3D applications, such as .ase or .obj. Then, if you want to go back and make changes to a scene, such 
as adding a lightmap or panorama, you have original, uncompressed files to work from. 

Follow These Steps to Optimize a Scene 
Use the sample files provided and follow the procedures below to learn how to optimize a model or scene file with 
Stream Tuning Studio. Optimized files from Stream Tuning Studio are smaller than typically produced from a 
modeling package and download in a way that is optimal for viewing.  

Important: Procedural geometries from Scene Builder and their applied textures cannot be optimized.  

1 Open File  From the File menu, choose Open and select the .mtx file for the scene you want to optimize. When 
you open an .mtx file, the Project Files area displays the .mtx file name with the accompanying .mts file name.  
• Open the tutorial file, cell_phone.mtx located C:\Program Files\Viewpoint\Viewpoint Stream Tuning 

Studio\Tutorial. 
• Click the .mts file name, and then click the View/Optimize button, to begin optimizing the .mts file. 

Note: Stream Tuning Studio references, but does not optimize, the .mtx file. However, by opening the .mtx 
file, you can view the maximum data about a scene and test its streaming with Modem Simulator. 
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2 Complete This Quick-Tuning Checklist 

Open the Image Viewer by choosing it from the Materials menu. By completing each of the following 
tasks in order, you can quickly optimize a scene without reducing either texture or geometry quality: 

Note: To enlarge the texture view in Image Viewer window, place your cursor over the divider between 
texture preview window and the main window. When you see the double-headed arrow, click and drag the 
divider down. To see an individual texture in a larger view with UV coordinates, double-click it. 

 
Image Viewer at the top of the Stream Tuning Studio screen displays all textures applied to an object. 

• Remove Duplicate Textures  Click in the Image Viewer, and then press Ctrl + A to select all textures. 
From the Material menu, choose Remove Duplicate Textures. In the Image Viewer tool, click the 
Lightmaps option button, and then choose Remove Duplicate Textures again. 
If you want to keep some textures as duplicates, deselect the textures before you choose Remove Duplicate 
Textures. In the upper display area where all textures are highlighted with colored bounding boxes, Ctrl + 
click on textures you want to keep. Then, from the Material menu, choose Remove Duplicate Textures.  

Note: The tutorial scene colored_cube_demo is especially useful for showing the effect of Remove 
Duplicate Texture. 

• Remove Unused Pixels  With all the textures selected, choose Remove Unused Pixels from the Material 
menu. Repeat this for lightmaps. 

• Rotate Textures  From the Material menu, choose Rotate Texture. Selecting one texture or lightmap at a 
time, click the Best button in the Rotate Texture tool, and then click the Set button to apply the rotation. 

• Check the New File Size  In the File Info tool on the lower left tool pad, click Calculate to see the effects 
of these simple optimizations on file size. 

Note: If this quick-tuning checklist reduces file size adequately, apply Fill Unused Pixels (from the Material 
menu) to textures and lightmaps as the final step and then save your file. 
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3 Adjust Dynamic Resolution to Reduce Poly (Triangle) Count and Set Minimum Initial Viewing 

• Click the arrow to the left of Dynamic Resolution to display the tool functions.  
• If the Delete button is not already enabled, click the Create button, and then adjust the Dynamic 

Resolution slider to a setting that does not degrade the geometry of the model, but reduces the overall 
triangle count.  

• View all sides of the model to ensure your settings do not degrade the geometry. Then, click the right 
scissors icon to finalize the operation. For more information, see “Set Maximum Poly Count” later in this 
guide. 

• To set minimum initial viewing, use the Dynamic Resolution slider as described above, but choose a 
minimum level of geometry quality you want for the initial view when streaming. Click the left scissors 
icon to set the minimum level of the initial view. 

For more information, see “Set Minimum Initial Viewing” later in this guide. 

 
Under Dynamic Resolution you can  
reduce total triangle (poly) count  
or set minimum initial viewing. 

4 Reduce Texture Quality  Preserve readability of textures with text by deselecting these textures as described 
above.  

Note: In Stream Tuning Studio 2.0, you have more control of texture compression. You can set the quality 
and compression format (JPEG or TrixelsNT) by the texture. 

• From the Material menu, choose Set Texture Quality.   
• Set the Quality to 40%, and then press the Enter key.  
• Preview the object by spinning it and zooming into it to be sure the quality is not visibly degraded. Adjust 

the quality as necessary. When finished, click the √ button to apply your changes.  
• Try this on the sample file. Select All (Ctrl + A). Then, deselect (Ctrl + click) the face and back textures of 

the cell before you reduce texture quality to preserve those textures with text. 

Important: In scenes containing text, use caution when adjusting size and quality of textures containing text. 
Reducing texture quality can degrade readability. 
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5 Resize Textures 
• From the Material menu, choose Image Viewer and Resize Textures. Select all textures in the image 

viewer (press Ctrl + A, or from the Edit menu, choose Select All Textures). 
• Click the Area option button, and then type 40% in the enabled field.  

Note: To deselect textures you don’t want adjusted, press the Ctrl key and click the textures. Determine 
which setting to use for each texture: Choose higher settings to preserve fine detail and lower settings for 
solid textures.  

• Preview the textures first before completing the operation. To preview the effects of a texture size setting, 
type the texture size, and then press Enter. You may change the texture size as many times as you want 
this way; changes aren’t applied until you click the √ button. 

 
Optional Functions 
• Merge Vertices  From the Shape menu, choose Merge Vertices. This closes the spaces between textures. 

The cell phone sample does not require this.  
• Merge Texture Coordinates  From the Material menu, choose Merge Texture Coordinates. A dialog box 

indicates how many coordinates have merged. There is no visual difference. The cell phone sample does 
not require this. 

• Material created from texture color  From the Material menu, choose Generate Material From Texture. 
When the object is streaming to the client, the average color of the entire object is displayed, rather than the 
default gray material typically seen during the initial streaming. This function is already applied to the cell 
phone sample files.  

• Modem Simulator  This feature works when the .mtx file is loaded. (In Project Files, click the .mtx file 
name, and then click Reload Scene.) Use this feature to simulate a scene streaming at different Internet 
connection speeds. 

6 Fill Unused Pixels  From the Material menu, choose Fill Unused Pixels. 

Note: For best results, Fill Unused Pixels should be your last step in optimization. 

7 Save the optimized file  

• From the File menu, choose Save.  
• Click OK. Be sure to save the file in a different directory than the original. 

Note: Stream Tuning Studio only optimizes and saves the .mts file. The .mtx file remains unchanged. 

Optimizing a Scene Containing Flash Content 
Viewpoint Experience Technology (VET) now supports Macromedia Flash™ compatibility. In Stream Tuning 
Studio, you can do the following to optimize your scene containing Flash content: 
• Optimize a texture to which a Flash movie is targeted.  
• Untile tiled textures, so that you can apply a Flash movie. 
• Create collage maps of textures you want to replace with Flash files. 
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Chapter 5: Additional Features 
New Features in This Release 

Fill Unused Pixels 
Fill Unused Pixels is a texture compression tool that allows you to further fine-tune scene file size while maintaining 
texture quality. This feature fills the unused pixels in a texture with white for optimum texture compression. 

Note: For best results, use Fill Unused Pixels as a final step in optimization. 

To fill unused pixels 
1 Choose Image Viewer from the Material menu.  
2 Select a texture, and then from the Material menu choose Fill Unused Pixels. 

Merge Textures 
Merging textures allows you to create a collage map of textures, so that all the textures included load at the same 
time. This may improve the appearance of a loading scene, but has little or no effect on overall file size. 

To merge textures 
1 Choose Image Viewer from the Material menu.  
2 Select the textures you want to merge, and then from the Material menu choose Merge Textures. 

Note: Although by merging textures, you create one large texture map, original texture references are retained 
by the .mts file so that it remains compatible with its .mtx file. 

Copy 3D Snapshot 
Choose Copy 3D Snapshot from the Edit menu to copy a screen shot of the scene window to the Windows 
clipboard. You must have an .mts file loaded for optimization for this feature to work. 

Untile Tiled Textures 
If you want to apply Flash content to a scene element where a tiled (repeated) texture is used, you must untile the 
texture, or the Flash movie will play in each tile of the texture. 

To untile a tiled texture 
1 Choose Image Viewer from the Material menu. 
2 From the Material menu, choose Rotate Textures. 
3 Select the tiled texture by clicking it. Double-click the texture to see the detailed texture view with UV 

coordinates. 
If you are uncertain which textures are tiled, choose Select Tiled Textures from the Material menu to 
highlight all tiled textures. Then, click the texture you want to select. 

4 In the Rotate Texture tool, click the Set button.  
This untiles the texture and stretches it to match the UV coordinates. 
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Additional Texture Controls 

Warning: Texture animations referencing textures stored in an .mts file may break if you delete or merge 
duplicate textures. 

To remove duplicate textures 
1 From the Material menu, choose Image Viewer. 

Be sure that duplicate textures are not referenced in an animation. Reload the .mtx file, and then choose 
Play Animation from the Scene Builder menu to inspect animations. 

2 Click inside the Image Viewer, and then press Crtl + A to select all textures. 
3 From the Material menu, choose Remove Duplicate Textures. 

To remove similar, but not identical, textures 
1 From the Material menu, choose Image Viewer. Double-click each texture to inspect it in a detailed view. 

Be sure that textures you remove are not referenced in an animation. Reload the .mtx file, and then choose 
Play Animation from the Scene Builder menu to inspect animations. 

2 In Image Viewer, click the texture with which you want to replace other similar. Press Ctrl + C to copy it. 
3 Click the texture you want to replace, and then press Ctrl + V. 

To select unused textures 
1 From the Material menu, choose Image Viewer. 

Be sure you do not delete or merge textures that may appear to be unused but are referenced in an 
animation. Reload the .mtx file, and then choose Play Animation from the Scene Builder menu to inspect 
animations. 

2 From the Material menu, choose Select Unused Textures. 

To select tiled textures 
Working in conjunction with Image Viewer, this tool allows you to select all tiled textures.  
1 Choose Image Viewer from the Material menu.  
2 On the Material menu, choose Select Tiled Textures.  
If the model contains no tiled textures, then no textures are selected. If the model tiled textures then all of them are 
selected.  
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Features Retained From Version 1.5 

Remove Unused Pixels 
Remove Unused Pixels allows you to reduce texture size without reducing texture quality. Pixels outside the mapped 
UV coordinates of a texture are removed, thus reducing file size. 

To remove unused pixels 
1 Choose Image Viewer from the Material menu.  
2 Select a texture, and then from the Material menu choose Remove Unused Pixels. 

Set Minimum Initial Viewing 
Stream Tuning Studio allows you to set lowest level of geometry quality at which an object is initially viewed when 
streaming. You can choose to have a general shape viewable initially, to have the entire object streamed before 
displaying, or any selection in between.  

To set minimum initial viewing 
1 In Project Files, click the .mts file you want to optimize, and then click the View/Optimize button. 
2 Click the arrow to the left of Dynamic Resolution to maximize that tool.  
3 If the Delete button is not already enabled, click the Create button, and then use the Dynamic Resolution slider 

to choose a setting that degrades the geometry of the model to a minimum level you want for the initial view 
when streaming.  

4 Click the left scissors icon to set the minimum level of the initial view. 
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Set Maximum Poly Count  
Use the Dynamic Resolution slider to set the maximum poly (triangle) count for an object. This simplifies an 
object’s geometry, so it’s important to weigh the trade-off between a more optimized model—and, therefore,  
smaller file size—and the visual quality of the model. 

Note: Setting maximum poly count is most useful for optimizing Viewpoint 3D Photo Studio models. Adjusting 
Dynamic Resolution may alter texture mapping. 

To set maximum poly count 
1 In the Project Files area, choose the .mts file you want to optimize, and then click the View/Optimize button. 
2 Click the arrow to the left of Dynamic Resolution to maximize that tool.  
3 If the Delete button is not already enabled, click the Create button, and then move the Dynamic Resolution 

slider to the left to reduce the number of triangles (poly count) in the model. 

Note: Adjusting Dynamic Resolution may alter texture mapping.  

4 Click the Delete button or the right scissors icon to set the maximum poly count. 

Note: Be sure to inspect the optimized model. If you want to change the maximum poly count setting, choose 
Undo from the Edit menu. Then, follow steps 3 and 4 to choose a new maximum poly count. 

Turn Objects Inside Out 
This function inverts the normals of an object. Use this function if an object (usually originating in a third-party 
application) appears inverted; for instance, it rotates opposite the direction of your mouse movement.  

Join Objects 
Separate objects in different bounding boxes can be joined so they share a single bounding box. Once joined, the 
objects move together and are optimized as a single object.  

1 Click the  tool, and then Ctrl-click each object you want to join. 
2 On the Shape menu, click Join Objects.  

If this selection is grayed, you did not select the objects correctly or there is only one object in the scene. 
To reselect objects, return to step 1. 
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Clamp Tiled Textures 
About Tiled Textures 
A texture is mapped onto an object by means of texture coordinates. The texture coordinate (0,0) corresponds to the 
lower-left corner of the texture, while (1,1) corresponds to the upper-right corner of the texture. When these texture 
coordinates are outside of the 1 × 1 square, the texture is tiled, or repeated, to cover the extra area.  
All tiled textures must have dimensions that are powers of 2 to display properly. When a file is saved, Stream 
Tuning Studio automatically detects which textures are tiled, and stretches them so that their dimensions are powers 
of 2. This means that a 127 × 513 texture becomes 128 × 1024.  
Sometimes, only one or two texture coordinates go outside of the 1 × 1 square, and moreover, this area is sometimes 
mapped to a very small triangle. In this case, the visual defect is almost unnoticeable. However, Stream Tuning 
Studio still treats such texture as tiled, and stretches it to the next power of 2, potentially increasing file size. To 
“clamp,” or constrain such textures, choose Clamp Tiled Textures from the Material menu. 
When Clamp Tiled Textures is applied, texture coordinates that would go outside of the texture rectangle are 
constrained to the size of the rectangle. If the texture is tiled multiple times, you see a significant change in the 3D 
view. To see the results of Clamp Tiled Textures, zoom into the model, and then apply Undo and Redo (Crtl + Z and 
Crtl + Y). 

To apply Clamp Tiled Textures to selected textures only 
1 Choose Image Viewer from the Material menu.  
2 Ctrl + click textures to select them.  
3 On the Material menu, choose Clamp Tiled Textures.  

Note: Clamp Tiled Textures tool does not improve the visual quality of the model, but it may slightly reduce 
file size.  
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Chapter 6: 
Help, Resources, and Feedback 
Viewpoint Developer Central: A Complete Resource 
The newly launched Viewpoint Developer Central Web site is a complete resource for Viewpoint Experience 
Technology (VET) developers. At Developer Central you can get Viewpoint applications, support, production tips 
and techniques, tutorials, and user guides—to name just a few of the offerings there. 
Go to Viewpoint Developer Central to 
• Get Assistance  For questions about using Viewpoint Experience Technology, click Support and go to the 

Viewpoint Forums. 
• Get Examples  Click Create Content and go to the Example Files. 
• Subscribe to the Viewpoint Developer Newsletter  Learn new production tips and techniques for creating 3D 

and rich media content for the Web with VET. 
• Give Feedback About Viewpoint Applications  Viewpoint Corporation values your feedback. Direct your 

comments and suggestions to the Viewpoint Forums. 
You can also visit Viewpoint Corporation’s main Web page for company news, links to Web sites featuring VET, 
and more. 

Download Viewpoint Applications, Guides, and Tutorials 
Viewpoint Developer Central is updated on an ongoing basis with the latest versions of its applications, user guides, 
and tutorials. Click Create Content to find links to the following. 

Viewpoint Applications 
You can download Viewpoint applications free of charge. Among applications available for download are 
• Viewpoint Media Player (VMP)  The Web browser plug-in necessary to view VET content with Netscape 

Navigator or Internet Explorer. 
• Viewpoint Scene Builder  An application designed to assemble and edit the content of a VET scene before its 

output to Viewpoint Media Files (.mts and .mtx/.mtz).  
• Viewpoint Media Publisher (formerly called MTX 2 HTML)  A utility that quickly creates an HTML page from 

a VET XML (.mtx/.mtz) file. This application provides a fast and convenient way for content creators to 
visualize a VET scene and animations within a Web page using the Viewpoint Media Player. 

• Viewpoint Control Panel  A utility designed to aid in the content creation, technical support, and development 
of VET-enabled Web sites and software.  

User Guides and Tutorials 
Get the most out of VET by learning with user guides and tutorials downloaded from Viewpoint Developer Central 
Web site.  
Available are user guides covering the family of Viewpoint applications. Also available for download are the 
Viewpoint Experience Technology XML Authoring Overview and Viewpoint Experience Technology XML Reference 
Guide documenting the XML tags that create and orchestrate all aspects of a VET scene.  
Tutorials use sample files to lead you step-by-step through a specific aspect of creating with VET. Download 
tutorials, such as “Texture Animation,” “Camera Animation,” and “JavaScript: Animations and Browser Control.” 

http://developer.viewpoint.com/
http://www.viewpoint.com/
http://developer.viewpoint.com/
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Appendix: Keyboard Shortcuts 
Press this… To do this… 

Ctrl+O  Open an existing document  

Ctrl+F4  Close active document  

Ctrl+.mts file  
listed at bottom  
of File menu 

Imports an .mts file into the active document. Must have an .mts file loaded; this does not 
work if you are in .mtx file mode. 

Ctrl+S  Save active document.  

Alt+F4  Exit application.  

Ctrl+Z  Undo.  

Ctrl+Y  Redo. 

Ctrl+X  Cut selected objects.  

Ctrl+C  Copy selected objects.  

Ctrl+V  Paste selected objects.  

Ctrl+D  Duplicate selected objects.  

Ctrl+A  Select all objects.  

Ctrl+Shift+A  Deselect all objects. 

Delete  Delete selected objects. 

Crtl+Alt+P  Activate Preferences dialog. 

F2  View selection. 

F3  View all. 

F9  Toggle left tool pad. 

F10  Toggle right tool pad. 

F11 Select next object. 

Home  Return camera to home position. 

Ctrl+Ins Set Home position. 

Ctrl+J  Join objects. 

Ctrl+ M Merge vertices. 

Right-click tool title 
bar. 

Displays a shortcut menu for expanding and collapsing the tool. Some tools also include a 
Close option. 

Ctrl+Drag  On object: Zooms plane.  
In Image Viewer: Zooms image. 

Shift+Drag  On object: Moves plane left, right, up, and down while key is down.  
In Image Viewer: Pans image. 
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Appendix B: Keyboard Shortcuts (con’t.) 

Press this… To do this… 
Alt  Switches to the Rotate Camera tool while key is down.  

Ctrl+E  Toggles Solo mode On/Off. In Solo mode, only selected objects are drawn; others are hidden. 

Ctrl+G  Generate Dynamic Resolution.   

Ctrl+Shift+G  Delete Dynamic Resolution.  

Ctrl+I   Display Dynamic Resolution. 

Ctrl+Tab  Select next document. 

Ctrl+Left Arrow  Rotates camera 90º around Y axis to the left.  

Ctrl+Right Arrow  Rotates camera 90º around Y axis to the right.  

Ctrl+Up Arrow  Rotates camera 90º around X axis up.  

Ctrl+Down Arrow  Rotates camera 90º around X axis down.  

Ctrl+Shift+Left 
Arrow  

Rotates camera 30º around Z axis counter-clockwise.  

Ctrl+Shift+Right 
Arrow  

Rotates camera 30º around Z axis clockwise.  

Left Arrow  Rotates camera 30º around Y axis to the left. 

Right Arrow  Rotate camera 30º around Y axis to the right.  

Up Arrow  Rotates camera 30º around X axis up.  

Down Arrow  Rotates camera 30º around X axis down.  
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